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Unless you have been living in a cave, you have certainly heard 
of eBay. Maybe you have even bought something from the 

site. I have done so and had a good experience each time. I have not, however, 
ever sold anything on eBay although I, like most other people, have items 
that I could sell if I knew how to get started. On March 17 we will all have the 
chance to learn from some experts. Our presenters are Mary Lou and Jerry 
Evans, who not only sell on eBay but who also run courses teaching others 
how to do so. This dynamic husband and wife team will show us the steps 
necessary for a successful start to our selling careers, whether we want to sell 
one item or start an internet business and clear out the garage and cellar at the 
same time. They will show us some tricks of the trade also, so we can become 
better sellers and smarter consumers as well. After the Evans’ presentation on 
March 17, you too can be a successful eBayer!

eBay Tricks of the Trade
by Linda Cober

http://www.keystonemac.com
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wants to learn something as quickly as possible to do just 
that. I read fast, so I prefer to read the whole chapter and 
absorb more of the fine points, but the Absolute Minimum 
does do a good job for the slower or time-pressed reader. 
Part III talks about selling on eBay, discussing what to do 
beforehand, how to sell items at a fixed price, how to create 
more effective item listings, how to use pictures in one’s 
listings, how to accept PayPal and other payment methods, 
how to pack and ship items cheaply and safely, and how to 
deal with non-paying buyers. This third section seems to 
cover much of what Mary Lou and Jerry will be teaching 
us at our meeting, so you can use it to reinforce what you 
learn March 17 or as a substitute if you are unable to attend 
the meeting. Part IV covers becoming an eBay power seller 
if you are so inclined, while Part V discusses managing 
your eBay activity with My eBay, creating your own eBay 
identity, and communicating with others in groups, boards 
and blogs. I found the Index to be very helpful as well, test-
ing it by trying to find quick answers to several questions. 
According to his bio, Michael Miller is a top eBay seller 
who has written more than 75 non-fiction books over the 
last twenty years, many of them about eBay. He obviously 
knows his topic and writes in an easy to understand, clear 
style that offers practical advice to those who want to get 
started using eBay. 

I hope to see you this March 17 for Mary Lou and Jerry’s 
program, but if you can’t attend yet are interested in learn-
ing how to use eBay, buy Michael Miller’s book Absolute 
Beginner’s Guide to eBay from Que Publishers. Either way, 
you won’t be disappointed!

President’s Corner

by Linda J. Cober

�

This Saint Patrick’s Day, come to KeyMac wearing 
the green or not, and learn how to make some 

green selling on eBay. Our presenters Mary Lou and Jerry 
Evans are successful eBay entrepreneurs who graciously 
agreed to share with us some of their hard-won tips for 
success. This evening with us will be a condensed version 
of an eBay sales course they teach, so we can benefit from 
their expertise and attend our March 17 KeyMac meeting 
as well.

If you cannot attend our March meeting and still want to 
learn how to sell on eBay, all is not lost. Que Publishers  
recently brought out the 5th edition of Michael Miller’s 
book Absolute Beginner’s Guide to eBay for  $21.99. I decided 
to report on this book since it ties in nicely with our up-
coming presentation. I found it to be quite helpful and well 
written, as its 5th edition status would indicate. 

Part I introduces the reader to the eBay marketplace and 
covers how to protect oneself on eBay, a good way to start. 
Part II covers buying on eBay, starting with browsing and 
searching for merchandise, bidding, sniping to win, using 
bid assistant and other bidding tools, buying fixed price 
items, paying for the purchase, buying safely, and secrets of 
successful bidders. I found sniping to win to be very inter-
esting and learned how some items that I thought I would 
win had been won by others who sniped, or bid in the last 
10 seconds after showing no interest or bidding in the days 
before the end of the auction. At the end of each chapter is 
a section entitled Absolute Minimum which summarizes 
the main points of the chapter and allows a reader who 
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Minutes 

by Gary Brandt, Recorder

President Linda Cober welcomed everyone to the February  
meeting and asked board members for their reports. Eric 
Adams told us he would be sending out requests to ven-
dors for donations for our auction in April. Eric asked if 
anyone had additional vendors that they wanted him to 
contact and he got a couple of suggestions. Tim Sullivan 
asked if anyone was having trouble opening the newslet-
ter since he had made a slight change. If you are having 
trouble, you might need to update your copy of Adobe 
Acrobat Reader. Linda Smith chose Google Earth 5.0 as 
our download pick of the month. She later demonstrated it 
during the program.

Tom Owad asked if anyone had a Mac II monitor that they 
could lend him. The monitor needed to be pre-MultiSync. 
Linda Cober said she might be able to help. A question was 
posed asking how many items could be plugged into a 
UPS. Non-essential items like printers need not be plugged 
in to the UPS, but the computer, monitor, and external hard 
drives should be. If power does go out, you should attempt 
to shut down as soon as possible. Someone mentioned APC 
as a trusted brand name. Their PowerChute software can 
be set up to automatically shut down a Mac. We got a 
comment from someone mentioning problems with a 
number of La Cie hard drives.

Tim Sullivan asked about entering 256 bit passwords. 
There are three different ways to enter WEP passwords 
for wireless networks so Tim might have to use a different 
method than he was trying.

Tom Bank is planning to buy a new Mac and he asked if 
there was a way to buy an individual service pack along 
with his Mac so he could get Snow Leopard for no ad-
ditional charge when it is released. We all have probably 
bought an item soon before something better was released. 
That’s just the breaks, Tom. Don Fortnum said there are some 
web sites that give a buy or don’t buy recommendation 

based on their guesses as to when new Macs would be 
released. MacRumors is one such site.

Eric Adams reported a problem with startup on his Mac. 
The startup process would begin and some startup items 
would be displayed but the process would stop and start 
over again. One troubleshooting idea proposed was 
starting in safe mode and checking the login items on the 
misbehaving account.

We watched Macworld Vodcast 91 in which Chris Breen 
demonstrated some new features of iPhoto ‘09. The new 
version works with GPS data. If you have a camera with-
out GPS capability built in, you might be able to add GPS 
to the camera with an attachment. To use geo-tagging in 
iPhoto, you check info on an event. You can move a pin on 
the map to the correct location to assign a location to all 
photos in that event. If you want to tag all of your photos 
with location data, Chris suggested creating a Smart Album 
of photos without location data and working on those 
until all are tagged. Chris also demonstrated the new Faces 
feature in iPhoto ‘09 and how to confirm faces so iPhoto 
will begin to recognize them.

Our webmaster Linda Smith presented the February 
program on all things Google. She began with Google 
Earth 5.0 which now includes a section in which you can 
view undersea areas of the world’s oceans. Our tour took 
us to the Forbidden City in Beijing. Users have uploaded 
photos of some of the interesting areas. We looked at Wash-
ington, DC and Captain Don’s Habitat in Bonaire. Linda 
Cober, a frequent visitor down there, pointed out points 
of interest. Google Earth works with the iPhone and iPod 
Touch. You can choose to display weather data with real-
time radar. Linda showed us street view which has been 
added for many areas. There are web sites that can lead 
you to interesting street views. Tom Bank II mentioned the 
Space Navigator 3D mouse that can make using Google 
Earth easier. Cost is around 59 dollars.

Linda next showed us how she uses Google Alerts to 
monitor her chosen search terms whenever they are 
mentioned on a web site. Google has a blog search feature 
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that narrows searches only to blog articles. With Google’s 
Book Search, you can read articles from the magazines and 
books it displays. Selections go way back in time. More 
current titles may have a page limit on what you can read 
online.

One of Linda’s favorite areas of Google is iGoogle where 
a user’s Google page can be customized. You can choose 
what features you want to display, such as weather data 
and headlines. You can register with Google to save this 
information. (In my experience, leaving your browser’s 
cookies for Google intact will retain the iGoogle settings 
without registration.)

The Google Calendar can import data from iCal calendars. 
Calendars can be accessed anywhere from any browser 
and they can be shared with other users if desired. Online 
collaboration can also be accomplished using Google Docs. 
Options include spreadsheets, forms, and presentations. 
Orkut is Google’s attempt at social networking.

The Knol section of Google is the place where users submit 
their articles to share their knowledge on areas of expertise. 

Picasa is in beta for Macs. It is a place to edit, organize and 
share photos. Google SketchUp allows you to create 
attractive 3D models using the online application. Tom 
Bank II pointed us to a web page where some of his 
professional SketchUp work was displayed.

Google’s Translate service lets you view web pages in 
many different languages. Google now owns YouTube 
where countless videos of all kinds have been posted by 
users. Google Labs is the area where Google is trying out 
new features. Another interesting feature from Google is 
Goog-411. Dial 1-800-GOOG-411 from any phone and give 
your location to get information on whatever local business 
you are searching for and Google will give you its choices 
and then connect you by calling that business for you.

Google has a multitude of other areas that can be helpful 
to you. Linda only showed us what time allowed. Take 
the time to explore the other areas and you may discover 
something that is invaluable to you. If so, let us know 
about it. Thanks, Linda, for starting us down that path.

by Oliver Habicht 

Photo Safe II Offers 
Worry Free Travel Backups

Recently my family took a three-week vacation overseas, 
and having left my computer at home (hey, it was a family  
vacation!), I needed a convenient way to store all the pho-
tos and videos that we were taking. Adam had written 
about this topic a few months ago (see ”Backing up Photos 
While Traveling”, 2008-08-11 and ”More Photo Backup 
Options While Traveling”, 2008-08-12) and since he had 
received a Digital Foci Photo Safe II for review after those 
articles appeared, he asked me to give it a real-world test.

The Photo Safe II is a lightweight (0.6 lb/272 g) portable 
photo storage device and memory card reader, and it 
proved a welcome traveling companion. With it, I was able 
to back up all our photos and videos as the trip progressed, 
copying them from our camera’s memory card every few 
days. I even had enough storage space to back up all the 
photos taken by the relatives who were traveling with us. 
And, although I didn’t use it to add data in this way, it can 
also work as a normal USB external hard disk (that’s how 
you move data from it to your Mac).

The Photo Safe II offers nearly foolproof backups. This is 
due to a variety of features, and assisted by the excellent 
Quick Start Guide which provides well written instructions, 
useful diagrams, and anticipates many user questions. 
Perhaps the most important of its features is that you can 
only delete photos from the device when it’s connected to 
a computer, effectively eliminating the risk of accidentally 
wiping out your entire trip’s pictures with the push of a 
button.

Further lessening that risk is the fact the Photo Safe II has 
only two buttons. One turns it on or off when held down, or, 
when pressed and released, toggles between pre-selecting  
the copy and delete functions. The second button then 

http://db.tidbits.com/author/Oliver%20Habicht
http://db.tidbits.com/article/9728
http://db.tidbits.com/article/9728
http://db.tidbits.com/article/9732
http://db.tidbits.com/article/9732
http://www.digitalfoci.com/photo_safe.html
http://www.tidbits.com/resources/2009-02/Photo-Safe-II.jpg
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executes either copying (all) files from memory card to the 
device, or deleting (all) files from the memory card. The 
latter action is somewhat safeguarded by requiring you to 
hold down the button for three seconds. And again, once 
photos are loaded onto the Photo Safe II, there’s no way to 
delete them using only the device’s controls.

Complicating things just a bit is the fact that the two buttons  
offer a few other context-dependent functions. These 
include recalculating the available space and displaying 
information (the number of files copying and the target 
folder number) following a copy. The former is clearly 
displayed, making it easy to know just how much room 
you have left. That said, depending on how you’re using 
the Photo Safe II, you may find you don’t need to check 
it often. With the (now-discontinued) 80 GB model, even 
after I copied several thousand photos and short videos to 
it, it still had over 56 GB available at the end of my trip. Of 
course, if you’re also using the device as an external hard 
disk, a more capacious model might be required.

It’s important to realize that each time you ask the Photo 
Safe II to copy a memory card, it does a complete copy of 
the card and puts the data in a completely new, top-level, 
sequentially numbered directory, prefaced with the card 
type. Also important to realize is that the copy action copies 
everything, not just photos and videos, but all directory 
structures as well.

If you have one memory card, and you choose to make 
backups during your trip without deleting files from the 
card, the last file copy will contain the entire contents of 
your card. You can then ignore all the previous copies.

However, if you’re copying more than one memory card 
of the same type, you need to compare the contents of the 
device’s sequentially numbered folders to make sure you 
get the correct data (since they’ll all have similar folder 
names). Apparently it’s possible to pre-create partitions on 
the device’s hard drive, thus permitting you to separate the 
data coming from different cards of the same type, though I 
didn’t try this.

However, I did successfully use the Photo Safe II with a 
wide variety of point-and-shoot and SLR cameras that 
utilized the following memory cards: SD (normal and HC), 
Sony Memory Stick Pro MagicGate (High-speed), xD, and 
Compact Flash. The Photo Safe II also has slots for many 
other types, such as CF Type I (including Sandisk Extreme 
III, IV), MMC, SD/HC, miniSD, MS, MS PRO, MS Duo, MS 
PRO Duo, and xD.

During the trip, I connected the Photo Safe II to a PC 
running Windows Vista (someone else’s, of course) and it 
performed admirably as an external hard drive. In fact, I 
even took the opportunity to make a full copy of all our 
card copies to create yet one more backup of everyone’s 
photos and videos!

The Photo Safe II can also copy data from MS/SD/MMC/
xD memory cards to a Compact Flash card. This would 
allow the risk-averse to create yet another level of backup. 
One could perhaps then mail full Compact Flash cards 
back home, or simply have enough peace of mind to delete 
the photos on the camera’s primary memory card.

The Photo Safe II can be powered with its included re-
chargeable battery, via the included AC adapter (sporting a 
small and lightweight wall plug that’s compatible with 100 
to 250 volt power mains), or via USB. Additionally, both the 
AC adapter and USB can be used to recharge the battery 
within the unit, something that’s lacking in most cameras 
(sorry, just a pet peeve there). Included in the package is an 
unusual forked USB cable. One end has a mini-USB con-
nector for connecting to the Photo Safe II, and the other end 
has a both normal USB connector for transferring data to a 
computer, and a second USB connector for delivery of even 
more power to the device, presumably to speed charging. 
Ingenious!

After a lengthy opportunity to explore the Photo Safe II, 
I’m left with only a handful of quibbles: When the device 
was connected to my Mac, I couldn’t see the data within 
the inserted memory cards, only the data on the device’s 
hard drive itself. However, according to the documentation, 
it’s supposed to function as a memory card reader.

Also, when powered by AC, I couldn’t get it to recognize 
the memory card. I had to pull the AC, turn it on with 
battery power, insert the memory card which would be 
recognized, and only then could I plug the AC in again and 
be fine thereafter.

Finally, and perhaps this was just an anomaly, at one point 
the device’s power indicator showed a single flashing bar 
when I was using just the battery, indicating a low battery. 
When I turned it off, and then back on, it indicated a full 
charge for quite some time.

Despite these minor quirks or aberrations, I highly 
recommend the Photo Safe II as the worry free means of 
backing up on the go. The Photo Safe II is currently avail-
able in 160 GB ($149), and 250 GB ($199) models, and can 
be purchased from Digital Foci’s Web site.

[Oliver B. Habicht is an IT director in the Cornell University 
Library. He’s still looking for a tiny and quick point-and-shoot 
digital camera that can charge via USB.]

Photo Safe II Offers 
Worry Free Travel Backups

http://www.digitalfoci.com/
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by Jeff Carlson 

10 Secrets of iMovie ‘09

I’m one of those people who thought iMovie ‘08 was 
pretty much okay. It advanced consumer video 

editing on the Mac in several ways, such as having live 
transitions and effects that don’t require re-rendering clips 
and putting your entire video library at your fingers without 
opening old projects.

But iMovie ‘08, having been written from scratch as a new 
application, was sparse in many areas, especially compared 
to its predecessor, iMovie HD 6. The good news is that 
iMovie ‘09 restores most of iMovie HD’s features. (Read 
my Macworld review of iMovie ‘09 for more.) The better 
news is that iMovie ‘09 boasts a lot of other new features 
and hidden secrets that aren’t immediately apparent.

I’m hard at work on my book iMovie ‘09 and iDVD for Mac 
OS X: Visual QuickStart Guide (click this link to pre-order 
it now and help support TidBITS), and am enjoying discov-
ering many of iMovie’s hidden tips and features. Here are 
10 things I’ve discovered that aren’t entirely obvious.

Double-click Clip to View Inspector — iMovie ‘09 
now collects its adjustment controls in a new Inspector 
heads-up-display, instead of providing separate floating 
panels for video and audio adjustments. You can select 
a clip and click the “i” icon in the toolbar, or choose an 
option from the new Action menu that appears on every 
clip, but it’s easier to double-click the clip to bring up the 
Inspector. (If you prefer iMovie ‘08’s behavior of double-
clicking a clip to play it, you can change the action in 
iMovie’s preferences.)

iMovie’s adjustment controls can also be invoked from the 
keyboard by pressing the following letters (with no modifier 
key): I for Clip adjustments; V for Video adjustments; A for 

Audio adjustments; and C for Cropping, Ken Burns and 
Rotation adjustments.

View Your Movie on a Secondary Display — iMovie’s 
monitor occupies the top-right corner of the program’s 
interface, and it can be resized by choosing one of the fol-
lowing sizes from the Window > Viewer submenu: Small 
(Command-8), Medium (Command-9), or Large (Com-
mand-0). That feature isn’t new, although the keystrokes 
have changed from iMovie ‘08.

What’s cool about iMovie ‘09 is that if you work with 
multiple displays, iMovie can use one of them as the 
monitor to play back your movie. Choose Window > Viewer 
on Secondary Display. (If you don’t see the menu item, 
make sure Show Advanced Tools is enabled in iMovie’s 
preferences.) This feature not only gives you a larger pre-
view - it scales to fit the screen - but it removes the monitor 
from the iMovie interface, giving you more horizontal 
room for editing your project.

Copy and Paste Adjustments — One of iMovie ‘09’s 
new features is the return of video effects. With a clip 
selected, bring up the Inspector and click the Video Effect 
button to view the effects iMovie offers. Now, let’s suppose 
that you also apply some other edits to the clip: increasing 
the exposure, muting the audio, applying image stabiliza-
tion, changing its speed, etc. Quite a lot can happen to one 
clip, as you can see. If the following clip (or other clips) 
come from the same scene, you’d have to reapply all of 
those adjustments to make them match up.

http://db.tidbits.com/author/Jeff%20Carlson
http://www.macworld.com/article/138676/2009/02/imovie09.html
http://www.amazon.com/dp/0321601327/?tag=tidbitselectro00
http://www.amazon.com/dp/0321601327/?tag=tidbitselectro00
http://www.tidbits.com/resources/2009-02/imovie_inspector.png
http://www.tidbits.com/resources/2009-02/imovie_vid_adjustments.png
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Instead, Apple expanded on a powerful feature that deserves 
attention. With the adjusted clip selected, choose Edit > 
Copy or press Command-C; all of the adjustments are 
copied. Then, choose one or more clips and choose which 
edits to apply from the Edit > Paste Adjustments submenu, 
either all at once or piecemeal. iMovie ‘08 could paste only 
video, audio, or crop adjustments. This version also adds 
cutaway edits, video effects, stabilization, speed, and map 
style adjustments.

Move Projects and Events to Other Drives — In 
iMovie ‘08, events (the folders in which raw footage was 
stored on the hard disk) could be kept on your computer’s 
startup disk or on external disks, but your movie projects 
had to be located on the startup disk. iMovie ‘09 lets you 
choose where projects are stored, too.

You can also move projects from drive to drive, such as you 
might want to do if your startup disk runs low on space. 
Relocating event files in iMovie ‘08 required that you move 
the applicable projects in the Finder. Now, drag a project or 
event to another drive’s icon in either the Project Library or 
the Event Library to copy the content. In the case of relocat-
ing project files, you’re given the option of copying just the 
project file or the file and its associated event footage, too. 
(Here’s a video example.) To move the files instead of copy 
them, hold the Command key while you drag.

Choose Which Clips Appear in Theme Transitions 
— iMovie ‘09 offers new themes that add motion graphics  

to your clips, specifically to your movie’s opening and 
closing scenes and some transitions. Some themes transition 
between two clips by, for example, focusing on one clip 
“mounted” to a bulletin board, zooming out, and then 
zooming in on the next clip. Other transitions have several 
clips on the bulletin board.

You can choose which clips appear in which frames. Click 
one of the theme transitions to view a zoomed-out image 
that displays all of the available drop zones. A set 
of numbered yellow pins appears on your footage, each 
representing one of the drop zones. Drag the pins to the ar-
eas of your movie you want to appear in the other photos. 
(Here’s a video example.)

Consistent Map Styles in Themes — Speaking of 
themes, the Bulletin Board theme includes a map tacked 
onto the background of the board. If you already have a 
map in your project, or you add a new map, the map style 
on the board automatically assumes the same style from 
the project for consistency.

Add Locations to Travel Maps — iMovie includes an 
internal database of 4,000 cities, airports, and other loca-
tions for use when adding markers to its interactive maps. 
That’s a good start, but what if you want a location that 
isn’t included? With a little work, you can add it to iMov-
ie’s database. (Credit for this tip goes to user markstew on 
Apple’s iMovie discussion forums.)

First, find the latitude and longitude coordinates of your 
destination using a service such as iTouchMap.com. Next, 
make sure iMovie is not running and open the applica-
tion’s package: Control-click on the iMovie application 
icon and choose Show Package Contents from the contex-
tual menu. (iMovie, like many applications, is a Mac OS X 
“package,” a folder that appears normally as a single file.)

Go to Contents/Resources/ and open the file WorldLoca-
tions.txt using a text editor. Copy an existing entry similar 
to the one you’re about to add; for example, find a city in 
your state or country. Paste that at the end of the list, and 
change the city name. Then, copy the coordinates you 
looked up on the Web and paste them in place of 
the coordinates in your custom line.

Save the file, close the folders, and launch iMovie. When 
you add a map and perform a search, your new location 
appears in the list.

The Date/Time Title — When you add this title style to 
a clip, the clip’s actual date and title appear. Only the start 

10 Secrets of iMovie ‘09

http://www.tidbits.com/resources/2009-02/imovie_paste_adjustments.png
http://www.tidbits.com/resources/2009-02/imovie_copy_project.mov
http://www.tidbits.com/resources/2009-02/imovie_theme_transitions.mov
http://www.tidbits.com/resources/2009-02/imovie_theme_transition.png
http://discussions.apple.com/profile.jspa?userID=1546095
http://itouchmap.com/latlong.html
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time is displayed - it won’t keep a running clock on your 
footage - and you can’t edit the text style. But if you need a 
quick notation of when the clip was shot, this title can save 
you some work.

View Photos from Same Time Period — If you’re like 
me, you capture not only video during a trip or other occa-
sion, but also a lot of still photos. iMovie ‘09 makes it easier 
to find the photos you shot at the same time.

Select an event in the Event Library and then click the 
Photos button on the toolbar. At the bottom of the Photos 
pane is a new Show Photos pop-up menu; click its check-
box and then choose a time frame (Within Event Date 
Range, or Within 1 Day/Week/Month of Event).

Adjust the Opacity of a Cutaway — With the advanced 
tools enabled (an option in iMovie’s preferences that 
unlocks a lot of features), you can drag one clip on top of 
another and create a cutaway - the new clip is superim-
posed on top of the existing one. When you bring up the 
Inspector on the cutaway clip, a new Opacity slider lets 
you adjust how transparent the clip appears.

http://www.tidbits.com/resources/2009-02/imovie_datetime_title.png
http://www.tidbits.com/resources/2009-02/imovie_show_photos.png
http://www.tidbits.com/resources/2009-02/imovie_cutaway_opacity.png
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Funtastic Photos 1.0.3
http://ohanaware.com/
Requires OS X 10.4 or greater. Universal Binary. $34.99

Funtastic Photos offers over 40 different 1-click effects that 
can be applied to your photos, turning them into works of 
art. If that’s not enough, go to the VIEW menu and pick 
ADVANCE OPTIONS. They will appear in a panel on the 
right side of the window. Check the various boxes to tweak 
your masterpiece.

There is available a range of inspiring layout designs, 
including amazing picture collages (or photo mosaics to 
some), photo cubes, mini Fun Books and simple greetings 
cards.

The built-in Photo Sharing makes it easy to quickly edit a 
photo and share it online using e-mail, Fun Cards (like the 
old Apple iCards), and upload directly to the most popular 
photo sharing sites such as Facebook, Picasa Web Albums, 
MobileMe & Flickr. Sharing photos is as simple as clicking 
a button on the toolbar!

The original image with Advanced Options opened.
Ohana Favorites / Digital Snow Fun

Artistic / Crazy Popy Arts
Romantic / Ink on Plastic

http://ohanaware.com/
http://www.facebook.com/
http://picasaweb.google.com/
http://www.me.com/
http://www.flickr.com/
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Apple Updates

Quick Fixes / Attempt It All Vintage Camera / 1880s Sepia

MacBook SMC Update 1.3
February 17, 2009 - 557KB
System Requirements

– OS X 10.5.6 

This SMC Firmware Update improves overall system  
stability and performance on MacBook computers.

Java for Mac OS X 10.5 Update 3
February 12, 2009
System Requirements

– OS X 10.5.6 

This release updates the Java Web Start and Java Applet 
components to address security and compatibility issues.

This release supports all Intel-based and PowerPC-based 
Macs and requires that Java for Mac OS X 10.5 Update 2 be 
already installed.

Java for Mac OS X 10.4, Release 8
February 12, 2009
System Requirements

–  OS X 10.5.6 

This release updates the Java Web Start and Java Applet 
components to address security and compatibility issues.

This release supports all Intel-based and PowerPC-based 
Macs and requires that Java for Mac OS X 10.5 Update 2 be 
already installed.

Security Update 2009-001 (Leopard).
February 12, 2009
System Requirements

– OS X 10.5.6 for Leopard

Security Update 2009-001 is recommended for all users and 
improves the security of Mac OS X.

Previous security updates have been incorporated into this 
security update.

Security Update 2009-001 (Tiger PPC)
February 12, 2009 
System Requirements

– OS X 10.4.11 Tiger

Security Update 2009-001 is recommended for all users and 
improves the security of Mac OS X.

Previous security updates have been incorporated into this 
security update.

Security Update 2009-001 (Tiger Intel)
February 12, 2009
System Requirements

– OS X 10.4.11 for Tiger

Security Update 2009-001 is recommended for all users and 
improves the security of Mac OS X.

Previous security updates have been incorporated into this 
security update.

GarageBand Update
February 4, 2009 
System Requirements

– OS X 10.5.6

This update improves overall stability and addresses 
specific issues with downloading lessons from the Learn to 
Play Lesson Store. It is recommended for all GarageBand 
09 users.

Pages Update 3.0.3
February 2, 2009

http://support.apple.com/downloads/MacBook_SMC_Update_1_3
http://support.apple.com/downloads/Java_for_Mac_OS_X_10_5_Update_3_
http://support.apple.com/downloads/_Java_for_Mac_OS_X_10_4__Release_8
http://support.apple.com/downloads/Security_Update_2009_001__Leopard_
http://support.apple.com/downloads/Security_Update_2009_001__Tiger_PPC_
http://support.apple.com/downloads/Security_Update_2009_001__Tiger_Intel_
http://support.apple.com/downloads/GarageBand_Update
http://support.apple.com/downloads/Pages_Update_3_0_3
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System Requirements

– OS X 10.4.10 or later
– OS X 10.5 or later 

This update addresses general compatibility issues

Keynote Update 4.0.4
February 2, 2009
System Requirements

– OS X 10.4.10 or later

– OS X 10.5 or later

This update addresses compatibility issues with Microsoft 
Office PowerPoint 2007 and Microsoft Office PowerPoint 
2008 as well as general compatibility issues.

Numbers Update 1.0.3

February 2, 2009

System Requirements
– OS X 10.4.10 or later
– OX X 10.5 or later 

This update addresses general compatibility issues.

Rumors and Reality
by Tim Sullivan

Around Apple
• The consensus seems to be that iLife ‘09 is a worthwhile 
improvement over the ’08 version. One of the most touted 
features is Learn to Play in GarageBand.

Major recording artists like Sting and Fall Out Boy teach 
how to play their hit songs. Additional lessons can be 
purchased for $4.99 apiece from a Lesson Store built into 
GarageBand.

Unfortunately while most of iLife ‘09 will run on a PPC, 
Learn to Play is one feature that absolutely requires an 
Intel. 

•June 8 is popping up in the rumor mill as a date to watch. 
The WWDC (World Wide Developers Conference) hasn’t 
been scheduled yet. However the second week of June has 
been blocked out at the Moscone Center in San Francisco 
for a “Corporate meeting.”

It also happens that Snow Leopard books are available for 
pre-order at Amazon.com and are scheduled for release in 
mid-June.

Those bits of information together with a lot of speculation 
has Steve Jobs returning (a little early) to introduce Snow 
Leopard and possibly some serious upgrades to the iPhone 
hardware and/or software.

As Sgt Schultz would say, “Verrry interesting.”

• While we are on the subject of Snow Leopard, some 
probable features (most of which can be toggled on or off):

– The automatic spell check will actually correct misspelling 
on the fly — “teh” will be replaced by “the.)

– Snow Leopard will incorporate “TypeIt4Me” functionality. 
Users create a list of character strings that are to be replaced 

with a substitution. For instance  “ tm ” would be replaced 
by ™; “OS 6” could be replaced by “Snow Leopard.”

– Another feature will be Data Detectors. For instance, 
when the system detects some text that appears to be a 
phone number or an address, it will offer to update the 
Address Book.

Turn-about: The music industry is beginning to seriously 
consider the possibilities of free downloads. Actually there 
would be a cost to the consumer, either by purchasing a 
new cell phone or in the Internet access contract. It 
is assumed that the consumers, by paying upfront, will be 
more willing to download music from legitimate sites.

The shift to this new way of thinking is taking hold over-
seas. As an example Nokia has introduced Comes With 
Music, a plan the comes with specific Nokia phones. Sub-
scribers can download as much music as they want from a 
five million track catalog.

The Isle of Man is planning to require broadband users to 
pay a monthly fee that would allow users to legally down-
load music from any source, even peer-to-peer services that 
are outlawed currently.

This is not to say that piracy is being endorsed. Countries 
such as France and Britain are considering legislation to 
curb piracy.

Internet traffic is increasing. Since there is a finite 
amount of bandwidth, transmission speeds suffer.

Last year Comcast assigned file sharing a low priority in 
transferring data. They abandoned that procedure by the 
end of the year, especially after being sanctioned by the 
FCC. While they have given up that system, they are now 
using one that doesn’t discriminate between different types 
of traffic.

This year, Cox Communications is testing their own version  
of network protocols in Kansas and Arkansas. Higher 

http://support.apple.com/downloads/Keynote_Update_4_0_4
http://support.apple.com/downloads/Numbers_Update_1_0_3
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Share Keystone MacCentral with other MACaholics

Name  _______________________________________________________________________

Address _____________________________________________________________________

City ______________________________________________ State ___  Zip _____________

Home Phone ___________________________ Day Phone ___________________________

E-mail Address  _______________________________________________________________

Date  __________________   Is this ❍ Renewal or ❍ New? 

How did you hear about us?  ___________________________________________________

Dues for one person are ❍ $20/yr.  Family or Corporate dues are ❍ $30/yr. 

To join Keystone MacCentral, mail 
this form with your membership dues 
(payable to Keystone MacCentral) to: 

    Keystone MacCentral
          Membership Chair
    305 Somerset Drive
    Shiresmanstown, PA 17011

Keystone MacCentral meetings are 
held  at 6:30 p.m. on the 3rd Tuesday 
of the month at Gannett Fleming, 209 
Senate Avenue, Camp Hill. 

priority will be assigned to Internet traffic it judges to be 
time-sensitive, like Web pages, streaming video and online 
games. File downloads, software updates and other non-
time sensitive data will be given low priority if there is 
congestion on the local network.

If you think keeping records for the annual IRS bare-
your-financial-records fete is a pain, just wait until you see 
bills .436 in the Senate and H.R.1076 in the House. Each 
of the companion bills is titled “Internet Stopping Adults 
Facilitating the Exploitation of Today’s Youth Act,” or 
Internet Safety Act.

If passed the law would require providers to keep records 
for two years to aid police investigations. The law would 
apply to all Internet providers and operators of millions of 
Wi-Fi spots.

Both bills state that “A provider of an electronic communi-
cation service or remote computing service shall retain for 

a period of at least two years all records or other information 
pertaining to the identity of a user of a temporarily as-
signed network address the service assigns to that user.”

Translated, the Internet Safety Act applies not only to 
major providers such as Comcast, but also to all homes 
with Wi-Fi access points or wired routers that use the 
standard method of dynamically assigning temporary  
addresses. (That method is called Dynamic Host  
Configuration Protocol, or DHCP.) The other method is  
PPPoE (Point-to-Point Protocol over Ethernet.)

Airwaves are not free. The U.S. government charges 
many telephone and wireless companies for use of the 
airwaves targeting mobile phone (read iPhone) and device 
users. This year that charge amounts to $50 million. The 
Office of Management and Budget wants $200 million f;or 
2010, with further escalation over the next decade. Much, if 
not all, of the cost will be passed on to the end user. 
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